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Introduction

This chapter covers routine operations which you might use on a
daily or weekly basis. This includes handling media, printing on
various media, handling and replacing toner, using Windows, using a
SCSiI disk, and removing downloaded fonts.

Media Handling

The quality of your printed output depends on many factors such as
the printer’s capabilities and application features. It also depends
heavily on the type of media (paper, labels, and transparencies)
selected and how you handle and store the media.

Selecting Media

Use the guidelines in this section to choose the best media for your
Accel-a-Writer 812 printing.
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Media Guidelines

Feeder Source  Sizes Media Capacity

Standard cassette Letter (8.50" x 11.00") Plain or laser  Approx. 250(shts.
A4 (210 mm x 297 mm)

Universal cassette Letter (8.50" x 11.00") Plain or laser  Approx. 250 fhts.

(optional) A4 (210 mm x 297 mm)
Legal (8.50" x 14.00")
Executive (7.25" x 10.50")
B5 (182 mm x 257 mm)

Fold Down Tray Letter (8.50" x 11.00") Plain or laser  Approx. 100 shts.
A4 (210 mm x 297 mm)  Transparencies Approx. 50 sh
Legal (8.50" x 14.00") Labels Approx. 40 shts
Executive (7.25" x 10.50") Envelopes Approx. 10 sht
B5 (182 mm x 257 mm)
Envelopes (US #10,
Monarch, 1SO DL, C5)

n

oY

500 sheet tray Letter (8.50" x 11.00") Plain or laser  Approx. 500 ghts.

(optional) A4 (210 mm x 297 mm)
Legal (8.50" x 14.00")
Executive (7.25" x 10.50")
B5 (182 mm x 257 mm)

Paper weights range from 17 Ib to 24 Ib (64 gm0 g/m) for
cassette feed and from 17 Ib to 34 Ib (64%gbrl28 g/M) for tray
feed.

Plain paper is more economical and works well for most general
purpose printing, such as in-house reports and general
correspondence. Laser paper, which is slightly more expensive, helps
ensure more consistent coverage and should be used when higher
quality is desired.

Transparencies and Labels should always be laser quality, capable of
handling 392° F (200° C) temperatures.
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Caution: If you use preprinted sheets such as letterhead, make
sure the ink on those sheets can withstand the 392° F
(200° C) temperatures. If not, the ink could cause
permanent damage to the printer’s fusing rollers. Also,
never use a partial sheet of labels or a sheet where glue
has soaked through the labels.

Avoid media which
¢ |s too thick or thin

* Isrough or extremely textured (such as course or
embossed stock)

e Has been or is wet or damp

e Is curled, torn, creased, or otherwise damaged
» Has metal clasps, strings, or staples

* Has any cutouts or perforations

« Is coated or synthetically reinforced stock

e Has exposed adhesives (such as partially used label stock)

When you select media, keep in mind that the physical page size is
different from the imageable area. The imageable area is the area
which can be printed on by your printer.

You should set the page margins in your applications to fit within the
imageable areas. If you try to print outside the imageable area, many
applications issue a warning or error message, giving you an
opportunity to make changes; some applications clip the image and
still print the page.
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The following chart gives the imageable areas for many standard
media sizes which can be used on your Accel-a-Writer 812 printer.

Paper

Letter
(Lettersmall)
(Note)

Legal

A4
(Adsmall)
B5

Executive

Envelopes

Com 10

Monarch

DL

C5
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Media
Size

8.50" x 11.00"
(216 mm x 279 mm)

8.50" x 14.00"
(216 mm x 356 mm)

8.26" x 11.69"
(210 mm x 297 mm)

7.17"x10.13"
(182.12 mm x 257.30 mm)

7.25" x 10.50"
(184 mm x 267 mm)

4.13" x 9.50"
(105 mm x 241 mm)

3.88" x 7.50"
(99 mm x 191 mm)

4.33"x 8.67"
(1120 mm x 220 mm)

6.39" x 9.01"
(162 mm x 229 mm)

Imageable
Areas

8.21" x 10.77"
(209 mm x 274 mm)

8.43" x 13.84"
(214 mm x 352 mm)

8.00" x 11.49"
(203 mm x 292 mm)

6.88" x 9.89"
(174.75 mm x 251.21 mm)

6.93" x 10.27"
(176 mm x 261 mm)

3.95" x 9.31"
(200 mm x 236 mm)

3.68" x 7.28"
(93 mm x 185 mm)

4.16" x 8.45"
(106 mm x 215 mm)

6.13" x 8.83"
(156 mm x 224 mm)




Regardless of the media you select, we recommend that you test
samples before buying in quantity. For more information on the
different media, see “Printing Transparencies,” “Printing
Envelopes,” and “Printing Labels” later in this chapter.

Storing Media

How you store media can have a major impact on the final print
quality and your printer’s operation. Media stored incorrectly
drastically increases the chance of printer jams and reduced print
quality.

To avoid problems, always store media
* On aflat surface
* With the media flat (not on its side or end)

* In stacks only if necessary and if the stacks are not too
heavy or high

e Inadark, dry, cool area

* Inits own wrapper

Feeding Media to the Printer

A major factor in printing is choosing the right method of feeding
your media to the printer. For most standard size, plain and laser
paper printing, feeding from the standard paper cassette is easiest.
For limited quantity, for odd-sized plain or laser paper printing, or
for transparencies, envelopes, and labels, you should use the fold
down paper tray.

When you print using a cassette or the fold down tray, media loads in
portrait orientation with the short edge first.
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If you use a universal cassette, it extends beyond the end of the
printer. You should install the universal cassette cover on the back of
the printer by gently fitting the cover pegs into the holes in the

printer as shown in figure 6.1. This cover prevents dust and debris
from getting into the paper tray and building up in the printer where

it can reduce print quality.

Fig. 6.1 Install the Universal Cassette Cover

The universal cassette cover can be left in place when you use other
cassettes in the printer.

Warning!  Never lift the printer by the universal cassette cover.
This cover is not permanently attached to the printer
and you could drop the printer causing personal injury
and permanent printer damage.

6-8 Routine Operations



Using a Paper Cassette

This section covers loading a cassette with laser quality or 20 Ib
photocopier paper. See “Printing Transparencies,” “Printing
Envelopes,” and “Printing Labels” later in this chapter, for specific
guidelines when using those forms of media.

Use the following procedure to refill and use the paper cassette for
printing.

1.  Pull the paper cassette straight out of the printer.

2. Prepare up to 250 sheets (approximately 1" [27 mm] or less) of
laser quality or 20 Ib photocopier paper. To do this:

a. Make sure the paper meets all requirements listed in
“Selecting Media” earlier in this chapter.

b.  Determine the printing side of the paper. Most packages
of paper have an arrow pointing in the direction of the
printing side on the wrapper.

C. Fan the paper to prevent it from sticking together, and
then align the edges to form a smooth stack.

d. Determine the leading edge of the paper. This varies
depending on the printing mode and paper size. See the
previous section, “Feeding Media to the Printer,” to
determine the leading edge.
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3.  Slide the paper printing side down, short edge first. Then press
down to make sure the paper is flat and under the metal clip at
the left front of the cassette (fig. 6.2).

Caution: Make sure the paper stack does not exceed the
upper paper limit marked on the cassette.
Overloading a cassette will cause paper to jam.

Fig. 6.2 Load the Paper Cassette
4.  Slide the cassette into the printer until it snaps into place.

5.  Select the paper cassette as the media source through the front
panel using the Tray Select key or through your application
(see your application documentation for details).

Note: In most cases when settings differ, application settings
have priority, followed by XANTE Utility settings,
and then printer’s front panel settings.

6. Print as you normally would.
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Using the Optional Lower Cassette

With the addition of the optional 500 sheet paper cassette and feeder,
you can increase your printer’s cassette capacity to 850 as well as
gain flexibility. For example, if you regularly use plain paper,
letterhead and legal paper, you can load up to 250 sheets of
letterhead in the standard upper cassette, another 500 sheets of plain
paper in the optional lower cassette, and 100 sheets of legal size
paper in the fold down tray. Select the desired source tray through
the front panel or your application.

Note: If you use a larger cassette than the Letter or the A4 sizes,
install the universal cassette cover on the back of the printer.
This cover prevents dust and debris from getting into and
building up in the printer where it can reduce print quality.

Media loading for both the standard letter or A4 cassette and the
optional 500 sheet cassette is the same. See the previous section,
“Using a Paper Cassette,” for details. Installing the 500 sheet cassette
and feeder is covered in chapter 9, “Options.”

Using the Fold Down Tray

Your Accel-a-Writer 812 has a built-in fold down tray on the front.
This tray is designed for both regular and manual feeding media.
You can feed up to 100 sheets of letter, A4, B5, Executive, and legal
paper as well as up to 50 transparencies, up to 40 label sheets or up
to 10 envelopes. You also can manually feed sheets of odd sized
media that measures from a minimum size of 3.5" by 6.5" (90 mm x
160 mm) to a maximum size of 8.5" by 14" (216 mm x 356 mm)
through this tray, including envelopes.

This section covers loading laser quality or 20 Ib photocopier paper
in the fold down tray. See “Printing Transparencies,” “Printing
Envelopes,” and “Printing Labels” later in this chapter, for specific
guidelines when using those forms of media.
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Use the following procedure to load the fold down tray.

1. Press and release the center top edge of the tray and ease the
tray down (fig. 6.3), making sure to support the tray as it
opens.

Fig. 6.3 Open the Fold Down Tray
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2. Pull out the tray extender (fig. 6.4).

Fig. 6.4 Pull Out the Tray Extender

3.  Prepare up to 100 sheets (approximately 3/8"[9.5 mm or less])
of laser or 20 Ib photocopier paper. To do this:

a. Make sure the media meets all requirements listed in
“Selecting Media” earlier in this chapter.

b. Determine the printing side of the media. Most packages
of paper have an arrow pointing in the direction of the
printing side on the wrapper or another form of label on
the media itself.

C. If you feed multiple sheets, fan paper to prevent it from
sticking together.

Note: If you use transparencies or labels, do not fan
the media; fanning transparencies causes static
build-up and fanning labels causes them to pull
loose from the backing.
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4.  Slide the media print side up, leading edge first into the fold
down tray.

Caution: Make sure the stack does not exceed the upper
paper limit marked on the tray (fig. 6.5).
Overloading will cause paper to jam.

Paper Limit Mark

Fig. 6.5 Load the Fold Down Tray

5.  Adjust the paper guides on each side so they rest lightly
against the media without causing it to buckle.

6.  Select the manual feed (fold down) tray as the source tray
through the front panel using the Tray Select key or through
your application (see the application documentation for
details). Otherwise, print as you normally would.

Note: In most cases when settings differ, application settings
have priority, followed by XANTE Utility settings,
and then front panel settings.
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Tray Chaining

If you add the optional 500 sheet lower cassette and feeder and use
two cassettes, you can “chain” the trays. This means when the first
cassette empties, the printer automatically switches to the second
cassette to pull media.

When you decide to chain trays, keep the following in mind:

» Chaining only works between the standard paper cassette
and the optional 500 sheet lower cassette with the feeder.
(You cannot chain using the fold down tray.)

* Both cassettes must contain the same size media.

* You can access tray chaining through the printer’s front
panel (see the next section, “Selecting Tray Chaining,” for
details) or through some applications if they offer that
feature.

« Make sure both trays are inserted properly. If not, tray
chaining will be disabled.

Selecting Tray Chaining
Use the following procedure to select tray chaining from the front
panel.

1. Pressthe Tray Select key. If auto tray switch does not appear
in the display window, continue pressing the Tray Select key
until auto tray switch appears in the display window.

2.  Press the On Line key to put the printer back on line.

Printing Transparencies

Always use the fold down tray when printing transparencies. Also,
keep the following in mind:

* Only use laser quality transparencies which can handle a
temperature of 392° F (200° C).
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« Avoid handling transparencies as much as possible to
prevent finger prints and scratches.

« Keep the paper path clean (see chapter 8 for details on
maintaining your printer). Because transparencies are
acetate and clear, any dust or dirt can scratch or reduce the
print quality.

e Load 50 sheets or less, making sure the stack does not
exceed the upper paper limit mark on the side of the fold
down tray.

« Load transparencies short edge first into the fold down
tray.

« Do not fan transparencies. This causes static build-up
which can cause jams.

» Try printing fewer transparencies at a time if jams occur
and remove each as it exits the printer. The more
transparencies loaded, the heavier the stack which could
cause the media to stick together. Removing transparencies
as soon as they print helps prevent static build-up when a
sheet slides out across the top of the previous sheet.

« Make sure to check for the correct printing side before
loading transparencies face up in the fold down tray. Most
brands label each transparency or mark the wrapper
accordingly.

Printing Envelopes

In its standard configuration, your printer runs up to 10 envelopes
automatically or you can print them individually using the fold down
tray.

If you run envelopes, keep the following in mind:

« Load envelopes face up with the stamp corners to the left
in the fold down tray.
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Make sure envelope stock falls within the guidelines for
the fold down tray listed in “Selecting Media” earlier in
this chapter.

Envelopes should range from 16 to 24 Ib (60 to 9C¢)gifm
stock weight.

Envelopes should fall within 3.5" x 6.3" (90 mm x 160
mm) to 6.9" x 9.8" (176 mm x 250 mm) in size.

Only use quality envelopes which can handle a
temperature of 392° F (200° C).

Before loading envelopes, place them on a flat surface and
press them smooth to make the corners and folds as flat as
possible.

Run the envelopes with the flap closed, and then open
them as soon as they emerge from the printer. This
prevents the heat during printing from sealing the
envelopes.

Do not use envelopes with exposed adhesives.

Do not use envelopes which are thick, rough, textured,
curled, torn, or otherwise damaged.

Do not use envelopes with metal clasps, strings, staples,
cutouts, or windows.

Do not use envelopes made from coated or synthetically
reinforced stock.

If you run preprinted envelopes, make sure the inks used in
preprinting can withstand fuser temperatures of 392° F
(200° C).

Format your envelopes in your application making sure
your return address margins are a minimum of .6" (15
mm). See your application documentation for more details.

Run a test print on plain paper to check alignment before
running on the more expensive envelope stock.
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Printing Labels

Always print labels from the fold down tray. When you run labels,
keep the following in mind:
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Load label sheets print side up in the fold down tray.

Make sure label stock falls within the guidelines for the
fold down tray listed in “Selecting Media” earlier in this
chapter.

Label stock should range from 0.0039" to 0.0045" (0.127
mm to 0.178 mm) in thickness.

Label stock should be letter or A4 in size.

Only use quality label stock which can handle a
temperature of 392° F (200° C).

If you run preprinted labels, make sure the inks used in
preprinting can withstand fuser temperatures of 392° F
(200° C).

Load 50 sheets or fewer, making sure the stack does not
exceed the upper paper limit mark on the side of the fold
down tray.

Make sure the sheets do not become packed down as they
are loaded into the fold down tray. If the stack is
compressed, it will expand as the sheets begin to feed into
the printer and this can cause a jam.

Make sure labels are not curled on the corners or coming
loose from the backing sheet.

Do not use label sheets with exposed adhesives (such as
partially used sheets or sheets on which the adhesive has
seeped through to the surface).

Do not use thick, rough, textured, curled, torn, or
otherwise damaged label stock.

Do not use coated or synthetically reinforced label stock.




« Format your labels in your application and run a test print
on plain paper to check alignment before running on the
more expensive label stock.

Adjusting Print Density

In most cases, your printer produces rich, black images. On rare
occasions, you may notice the image is slightly darker or lighter than
desired. If this is the case, you have two options. You can
redistribute toner in the cartridge or make fine adjustments using the
Density menu through the printer’s front panel.

Since toner has the tendency to settle when not used for several days,
we suggest you try redistributing the toner first. Then, if you still feel
you want to make an adjustment, use the Density menu via the front
panel. Both of these procedures are covered in this section.

Redistributing Toner

Toner tends to pack down and settle unevenly when not used for
several days. In this case, you need to redistribute it using the
following procedure.

Caution: The toner cartridge is sensitive to bright lights and direct
sunlight. Do not keep it out of the printer for any
extended period of time. The cartridge contains a
magnet, so keep it away from your hard disk(s) and
monitor to prevent possible data loss or equipment
damage.
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1. Open the top cover by pressing in on the raised finger grips on
each side and lifting up and back approximately°X86. 6.6).

Fig. 6.6 Open the Top Cover

2. Grasp the toner cartridge by the grip area, raise that end
slightly, and then pull the cartridge out of the printer (fig. 6.7).

Fig. 6.7 Remove the Toner Cartridge
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Gently rock the cartridge back and forth to distribute the toner
evenly throughout the cartridge (fig. 6.8).

Fig. 6.8 Distribute the Toner

Note: If the toner is running low, you may want to install a
new cartridge. If so, see “Handling and Replacing the
Toner Cartridge” later in this chapter for details.
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4.  Holding the toner cartridge with both hands (fig. 6.9), align
and slide the cartridge back into the printer until it rests
securely in place. If the cartridge is not seated correctly, the
top cover will not close completely.

Fig. 6.9 Load the Toner Cartridge
5.  Close the printer’s top cover gently until it snaps into place.

6.  Print a test file to check the density. If redistributing the toner
has not corrected the situation, install a new toner cartridge.
See “Handling and Replacing the Toner Cartridge” later in this
chapter for details.

Note: Never move or ship the printer with a toner cartridge
installed.

Adjusting Density through the Front Panel

You can make fine adjustments to print density via the front panel
Density menu. This menu allows you to select a value from 0
through 15 with O being the lightest setting and 15 the heaviest. The

default setting is 7.
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Use the following procedure to change density settings. This
example selects a value of 9.

1. Make sure the printer is on and idle.

2.  Press the Menu key until SETUP:MISC (the Miscellaneous
menu) appears in the display window.

3.  Press the Enterkey to enter the Miscellaneous menu.

4. Press the Menu key until MISC:DENSITY appears in the
display window.

5.  Press the Enterkey to enter the Density menu.

6. Pressthe Menu key until density:9 appears, if necessary. If
DENSITY is capitalized, then 9 is already the default density
setting; skip to step 8.

7.  Press the Enterkey to select density:9. The selection changes
to all capital letters, DENSITY:9, in the display window.

8.  Press the On Line key. READY/IDLE appears in the display
window.

The printer now has 9 selected as the density setting.

Handling and
Replacing the Toner Cartridge

Your Accel-a-Writer 812 uses a standard EP-E toner cartridge. This
handy one-piece cartridge combines the toner, the drum, the
developer assembly, and the main charging roller so you only have

to replace one consumable that averages 6000 letter/A4 size copies al
4% coverage.
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When you handle the toner cartridge, keep the following in mind:

e The toner cartridge is sensitive to bright lights and direct
sunlight. Leave it in its protective bag until you are ready
to load it into the printer.

* The cartridge contains a magnet, so keep it away from
your hard disk(s) and monitor to prevent possible data loss.

* When you store the cartridge, keep it length-wise on a
level surface. Do not stand it on end or upside-down.

« Use a cartridge before its expiration date to maintain
maximum print quality.

We recommend you use only new toner cartridges.
Refilled cartridges may vary in quality and reliability, and
toner leaks could affect your printer warranty.

* New or stored cartridges may require a breaking in run of
approximately 50 copies. This is because toner settles
during prolonged storage.

e If you do not use the printer for a week or two, you may
need to run 3 or 4 copies to loosen the toner. Or, for longer
periods, you may need to remove the cartridge and gently
rock it back and forth to redistribute the toner in the
cartridge. See “Redistributing Toner” earlier in this chapter
for detalils.

Removing the Old Cartridge

When you remove an old toner cartridge, you should also clean the
anti-static teeth which will help prevent paper jams. Use the
following procedure to remove the cartridge and clean the teeth.

1. Open the top cover by pressing in on the raised finger grips on
each side and lifting up and back approximately’180. 6.6).
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2. Grasp the toner cartridge by the grip area, raise that end
slightly, and then pull the cartridge out of the printer (fig.
6.10).

Fig. 6.10 Remove the Toner Cartridge

Warning!  The toner is highly combustible. Never dispose of it by
incineration.
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3.  Check the anti-static teeth area for paper dust and scrap residue
(fig. 6.11). If there is none, skip to the next section, “Installing
the New Cartridge.”

4.  Clean off the dust and paper residue from the anti-static teeth
using the following procedure.

a. Locate and remove the green cleaning brush inside the
right side of the printer (fig. 6.11)

b. Locate the anti-static teeth and slide the cleaning brush
back and forth across them several times to remove
residue (fig. 6.11).

C. Replace the brush in the right side of the printer (fig.
6.11).

Fig. 6.11 Clean the Anti-Static Teeth Area

Now that you have removed the old toner cartridge and cleaned the
anti-static teeth, you are ready to install a new cartridge using the
procedure in the next section.
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Installing the New Cartridge

Use the following procedure to install a new EP-E toner cartridge.

1. Remove the new toner cartridge from its package and gently
rock it to distribute the toner evenly throughout the cartridge
(fig. 6.12).

Fig. 6.12 Distribute the Toner
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2.  Place the cartridge on a flat surface and gently flex the black
end tab on the sealing tape back and forth until it becomes
loose. Then, pull the tab and 21" tape straight out from the
toner cartridge and discard it (fig. 6.13).

Fig. 6.13 Remove the Toner Sealing Tape
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3.  Holding the cartridge with both hands, align and slide the
cartridge into the printer until it rests securely in place (fig.
6.14). If the toner cartridge is not seated in place, the top cover

will not close.

Fig. 6.14 Load the Toner Cartridge
4.  Close the printer’s top cover until it snaps into place.

Caution:  Never move or ship the printer with a toner
cartridge installed. Toner spills can damage the

printer.

Remember that a new cartridge has a break-in period (see “Handling
and Replacing the Toner Cartridge” earlier in this chapter for
details).
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Using Macintosh Applications

When operating in a Macintosh computing environment, specific
printing tasks may vary depending upon the application. For
example, selections for the number of copies to print, the page
orientation, and the media size options are located under different
menus or dialog boxes. You need to check the application
documentation to determine where to find and how to use these
options.

You can make these selections through the printer’s front panel using
the procedure in “Selecting Menu Options” in chapter 5. However, in
most cases application selections override those made through the
front panel. If there is a question or if the job does not print as
expected, select the desired setting through both the application and
the front panel.

Some, but not all, Macintosh applications have resolution options for
the printer. Since many factors affect resolution selection, this task is
covered separately in the following section.

Note: See appendix C, “Application Notes,” for details on specific
applications.

Selecting Resolutions

Your Accel-a-Writer 812 printer offers 1200 x 1200 dpi and 600 x
600 dpi (dots per inch) resolution printing.

Note: Occasionally, a large, complex file or one with heavy
graphics requires more than the standard memory to print.
This also varies depending on the chosen resolution.
Memory upgrades can provide the extra space required. See
“RAM Upgrades” in chapter 9 for details.

When you select resolutions, remember that other factors affect the
quality of your output. For example, the type and condition of the
media, the capability of your application, and the level of toner and
its distribution can affect output.
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The easiest way to select a resolution is through the printer’s front
panel. This step-by-step process is covered in “Selecting Menu
Options” in chapter 5.

Some, but not all, Macintosh applications have resolution options for
the printer. Check the application’s documentation to see if this
option is available and, if so, how to select it.

Note: Adobe PageMaker has its own Print dialog box which does
not include a resolution option. If you use PageMaker, you
must set the resolution through the printer’s front panel.

If you use LaserWriter 8.x software, you can select the resolution
using the following procedure.

1. Select Print from the File menu. The Print window appears.
2. Select Options. The Print Options window appears.

3.  Select the desired resolution.

4. Click OK. The Print window reappears.

5. Click Print to send the file to the printer.

Usually application selections override front panel settings. If there
is a question or if the job does not print in the desired resolution, set
both the application and the front panel to the desired resolution.
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Using Windows

XANTE has created a Windows 3.1 printer description file
(XTAW8121_1.PPD) to help you print from Windows and Windows
applications. Installing this file is covered in chapter 4. Using this
file and the Adobe Windows driver with your Windows applications
to perform routine activities such as selecting resolutions, the
number of copies to print, manual feed, and the media orientation
and size are covered in tAdobe PostScript Printer Driver User’s
Guide That user’s guide also includes information on printing to a
file, downloading Type 1 fonts, a summary of printer settings, and a
troubleshooting section.

If you run into questions or problems working in a Windows
application, see chapter 10, “Troubleshooting,” in this manual, the
Adobe PostScript Printer Driver User’s Guida your Windows
documentation.

Note: You should be familiar with all standard Windows
procedures. This includes how to click, drag, copy, choose
commands, select options, use buttons and boxes, locate
files, and scroll in windows. If you have any questions about
these procedures, see your Windows documentation or the
Windows Tutorial under the Help menu in the main
Windows program.

Changing PC Communication Settings

When you install the XANTE XTAWS8121.PPD) for Windows, the
communication selection is set automatically to LPT1: (parallel).
You can change this to any serial (COM) port or parallel (LPT) port
available on your printer by using the following procedure.

1.  Start your Windows application.
2. Open the Program Manager and locate the Main group.

3.  Double-click the Main group icon to open that window.
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4.  Double-click the Control Panel icon to open that window.

5.  Double-click the Printers icon to open that window (fig. 6.15).

= Printers

Default Printer
( Apple LaserWriter II NT on LPT1 ‘

Cancel

[ Installed Printers

Accel-a-Writer 812 on LPT1 N\
Apple Lase e on LP Setup...
PostScript Printer on LPT1

VariTyper VT-600 on LPT1 Remove

Set as Default Printer I

Help

X Use Print Manager

Fig. 6.15 The Printers Window
6. Click Accel-a-Writer 812 on LPT1... to select it.

7.  Click Connect... (fig. 6.15). A window displays showing the
available interfaces.

8.  Select the interface to which your printer is connected.
9. Click OK.
10. Close all open windows.

11. Resume the printing process in your application.

Using a SCSI Disk

The XANTE Accel-a-Writer 812 supports multiple SCSI disks of
unlimited size. In most cases, a 20 MB SCSI disk is large enough; it
typically has space for 500 to 600 fonts.
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For information on installing a SCSI disk, see “Connecting a Hard
Disk” in chapter 2. That section also covers initializing a hard disk.

Note: Do not confuse the serial and SCSI interface ports when
connecting the cables. The printer has a 9-pin serial port, and
the printer ports are labeled clearly.

If you want to download fonts to the SCSI disk, see “Downloading to
a Hard Disk” in chapter 3 for a Macintosh environment or in chapter

4 for a PC environment. To remove downloaded fonts from the SCSI
disk, see the next section, “Removing Downloaded Fonts.”

Removing Downloaded Fonts

To remove all downloaded fonts from printer memory, simply turn
the printer off and then back on. Fonts stored in printer memory only
last for the current power cycle. You can remove individual
downloaded fonts from memory with the Downloader in a Macintosh
environment, but not in a PC environment.

Removing downloaded fonts from a SCSI hard disk varies depending
upon the environment in which you work. This rest of this section
covers the Macintosh environment and then the PC environment.

In a Macintosh Environment, if you want to download fonts, the
Downloader included in your XANTE Utilities works best. See
“Loading Printer Fonts” in chapter 3 for details on downloading and
listing fonts on a SCSI disk.

To remove a font from the SCSI disk use the following procedure:

1. Make sure the SCSI disk is powered on and attached to the
printer's SCSI interface.

Note: Do not confuse the serial and SCSI interface ports
when connecting the cables. The printer has a 9-pin
serial port, and the printer ports are labeled clearly.
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2.  Locate the Downloader 5.0.5 utility and double-click the icon
to open the utility.

3.  Choose Download Font located under the File menu. After the
program locates the printer, a screen similar to the following

appears.

Outline Fonts Available: Outline Fonts Selected:

< Fonts W I Device
D Ameri ﬁ ) Macinto... Ameri ﬁ
'] AmeriBol AmeriBol
[ ) AmeriExtBol

" Deskto

[ Amerilta P
[ ] AvantGarBoo Add
D AvantGarBooObl
[ ] AvantGarDem Add Al
[] AvantGarDemObil
D BenguBoI e ——
[ Bengusan

Bodon
D BodonBol
[ BodonBollta
D BodonPos || |
[) BookmDem Iy iy

Fig. 6.16 Remove Fonts from Disk

4.  Make sure Disk (not Memory) is selected in the upper right
corner of the window (fig. 6.16).

5.  Select the font(s) you want to remove. To do this if you wish
to remove all fonts, skip to step 6. Otherwise, select the
individual font, then click Remove, and skip to step 7.

Note: If you want to remove several but not all fonts, you
have to select and remove each one separately.

6. Select any font in the right-hand window. The Add All option
in the window changes to Remove All. Then, select Remove
all to remove all the fonts

7. Wait until the removing process finishes.
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8. Choose Quit from the File menu.

In a PC Environment, if you want to download fonts to a SCSI

disk, use the downloader in the Adobe Windows driver located under
Printer Setup. See “Loading Printer Fonts” in chapter 4 for more
details.

To remove fonts from a SCSI drive, you have two options. First, you
can use PSDown.exe which comes with your fonts. See the
PSDown.exe documentation for details. This is the best method if
you want to remove only a few of the fonts.

Your second choice is to reinitialize the SCSI disk by downloading
the INITDSK.PS file. See “Initializing a Hard Disk with the PC” in
chapter 2 for details.

000
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